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« This user manual provides important information and instructions for the usage of the product. It is essential to

read and understand this manual to ensure the proper use of the product.

Notices

« All rights of this user’'s manual belong to T&D Corporation.

« Any unauthorized use, duplication, or arrangement of this manual is strictly prohibited without the permission
of T&D Corporation.

« Microsoft and Windows are registered trademarks of Microsoft Corporation.

« Company names and product names mentioned in this manual are trademarks or registered trademarks of
their respective companies.

« Specifications, design, and other contents are subject to change without notice.

« The on-screen messages in this manual may slightly differ from the actual messages.

« Please report any mistakes, errors, or unclear explanations in this manual to the shop where you purchased
the product or to T&D Corporation. T&D Corporation will not be responsible for any damage or loss of income
caused by the use of the product.

« This product is intended for private or industrial use only. It should not be used in situations where strict safety
precautions are necessary, such as in connection with medical equipment.

« T&D Corporation is not responsible for any malfunction or trouble caused by the use of the product or any
problems arising from the use of measurement results obtained from the unit.

« Some products may require permission from the Japanese government to be exported outside of Japan due to
foreign trade laws.

« The user manual can be downloaded from the T&D Corporation website: tandd.com.

Software User Agreement
Disclaimers

« T&D Corporation does not guarantee the operation of T&D Recorder for Windows TR-5,7xU.

« T&D Corporation shall not accept any responsibility for any damage, whether direct or indirect, resulting from
the usage of T&D Recorder for Windows TR-5,7xU.

« Specifications of T&D Recorder for Windows TR-5,7xU may change, and the service may be terminated
without advance notice.

« T&D Corporation will not be responsible for any damages resulting from the inability to use T&D Recorder for
Windows TR-5,7xU.

« T&D Corporation is not obligated to correct any defects found in T&D Recorder for Windows TR-5,7xU.

Copyright

« The copyright for T&D Recorder for Windows, including the program and relevant documents, belongs solely to
T&D Corporation.

« The reprinting or redistribution of T&D Recorder for Windows for commercial purposes, whether in part or in
whole, in magazines or as part of any product, is strictly forbidden without the expressed consent of T&D
Corporation. For inquiries regarding commercial redistribution, please contact the Sales Department of T&D

Corporation.
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« Modifications or changes to T&D Recorder for Windows TR-5,7xU are not recommended.

Product Usage Instructions

1. Section 1: Introduction
In this section, you will find an introduction to the product and its purpose.

2. Section 2: Installation
This section provides step-by-step instructions on how to install the product. It includes information on system
requirements and software compatibility.

3. Section 3: Setup
Here, you will find instructions on how to set up the product for first-time use. It includes information on
configuring settings and connecting peripherals.

4. Section 4: Operation
This section covers the basic operation of the product. It includes information on navigating the user interface,
performing tasks, and troubleshooting common issues.

5. Section 5: Advanced Features
In this section, you will learn about the advanced features and functionalities of the product. It provides detailed
instructions on how to utilize these features effectively.

6. Section 6: Maintenance
Here, you will find guidelines on how to properly maintain the product to ensure its longevity and optimal
performance. It includes information on cleaning, storage, and firmware updates.

7. Section 7: Troubleshooting
This section provides a comprehensive list of common issues and their solutions. It helps users troubleshoot
problems they may encounter during product usage.
Section 8: Safety Precautions
In this section, you will find important safety precautions and guidelines for the usage of the product. It includes

information on electrical safety, handling precautions, and environmental considerations.

Specifications

o Product Name: [Product Name]

« Manufacturer: T&D Corporation

o Model Number: [Model Number]

o Weight: [Weight]

» Dimensions: [Dimensions]

« Power Source: [Power Source]

« Operating Temperature: [Operating Temperature Range]

« Storage Temperature: [Storage Temperature Range]

« Supported Operating Systems: [Supported Operating Systems]
« Connectivity: [Connectivity Options]

o Warranty: [Warranty Details]

Frequently Asked Questions (FAQ)



1. Q1: Can | use this product with medical equipment?
A1: No, this product is not suitable for use with medical equipment. It is designed for private or industrial use
only.

2. Q2: Where can | download the user manual?
A2: The user manual can be downloaded from the T&D Corporation website at tandd.com.

3. Q3: What should I do if | encounter a problem during product usage?
A3: Please refer to the troubleshooting section of the user manual for solutions to common issues. If the
problem persists, contact the shop where you purchased the product or reach out to T&D Corporation for
further assistance.

4. Q4: Can | modify the software?
A4: No, it is not recommended to make any changes or modifications to the software. Doing so may result in

unintended consequences and void any warranty or support provided by T&D Corporation.

Notices about this User’s Manual

o Carefully read this manual so that you can properly use this product.

« T&D Corporation accepts no responsibility for any malfunction of and/or trouble with this product or with your
computer that is caused by the improper handling of this product and will deem such trouble or malfunction as
falling outside the conditions for free repair of the attached warranty.

« All rights of this user's manual belong to T&D Corporation. It is prohibited to use, duplicate and/or arrange a
part or whole of this user's manual without the permission of T&D Corporation.

« Microsoft and Windows are registered trademarks of Microsoft Corpo-ration in the United States ands/or other
countries.

« Company names and product names are trademarks or registered trademarks of each company.

« Specifications, design and other contents are subject to change without

« On screen messages in this manual may vary slightly from the actual messages.

« Please notify the shop where you purchased this product or T&D Corporation of any mistakes, errors or
unclear explanations in this manual. T&D Corporation accepts no responsibility for any damage or loss of
income caused by the use of our product.

» This product has been designed for private or industrial use only. It is not for use in situations where strict
safety precautions are necessary such as in connection with medical equipment, whether directly or indirectly.

» We are not responsible for any malfunction or trouble caused by the use of our product or by any problem
caused by the use of measurement results of our unit. Please be fully aware of this before using our product.

« Some of our products, which come under the category of strategic goods in foreign trade law, need the
permission of the Japanese government to be exported outside of Japan.

« The Manual itself can be downloaded from our Web Site: tandd.com.

Software User Agreement

Disclaimers

« T&D Corporation does not guarantee the operation of “T&D Recorder for Windows TR-5,7xU”.
« T&D Corporation shall not accept any responsibility for any damage, whether direct or indirect, that results from
the usage of “T&D Recorder for Windows TR-5,7xU”.
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« Specifications of “T&D Recorder for Windows TR-5,7xU” may be subject to change and service may be
terminated without advance notice to the user. In such a case, T&D Corporation shall not be responsible for
any damages, whether direct or indirect, from the inability to use “T&D Recorder for Windows TR-5,7xU".

« T&D Corporation has no obligation to correct any defects found in “T&D Recorder for Windows TR-5,7xU".

Copyright

« The Copyright for T&D Recorder for Windows, including the program and relevant documents, belongs solely
to T&D Corporation.

« The reprinting or redistribution for commercial purposes whether in part or in whole, in magazines or as a part
of any product is strictly forbidden without the expressed consent of T&D Corporation. Any inquires concerning
commercial redistribution should be directed to the Sales Department of T&D Corporation.

« Please do not attempt to make any changes or modifications to “T&D Recorder for Windows TR-5,7xU”.

Using this software

Notes about graph operation

« Opening a Temp / Humidity Graph or other data file (.trx, etc...) by dropping it into the Graph window
If you wish to open a file by dropping it into a Graph, it will not appear if the Graph has been opened using [Run
as Administrator]. Please open the Graph as a general User. In general, we suggest to only use [Run as
Administrator] to open the Graphs the first time in order to link the type of data files (extension) to the Graph
programs. After that please open as a general user and carry out the opening of data as usual.

« About the Saving Location for Data Files
The application automatically creates a new data file each time an Auto-Download session occurs. Note that
the [Virtual Store] function will redirect files from the default folder into which the program was installed to
separate folders under [Program Files] for each user, as shown below: [C:\User\(Account
Name)\AppData\Local\Virtual Store\ Program Files\(Application)].

« EX
If login was carried out using the account name [myname] and [T&D Recorder for Windows] is the application
being run, the saving location will appear in the application window as: [C:\Program Files\(Application)] but due
to the
[Virtual Store] function the actual saving location will be [C:\User\myname\
AppData\Local\VirtualStore\Program Files\(Application)].
If the login was carried out from [Run as Administrator], the file will be saved to the folder as it appears in the

application window.

What is “T&D Recorder for Windows TR-5,7xU”’?

« An Overview
“T&D Recorder for Windows TR-5,7xU” is a software program that enables you to easily make recording
settings for our Data Loggers, download recorded data from the loggers, and then process that data into
graphs, tables and/or save that data to files or print. Upon opening “T&D Recorder for Windows TR-5,7xU”, a

launcher program will appear with several icons lined up. By clicking on an icon, a settings / communication



display for the selected type of device or a graph display will appear.
« Compatible Devices
o Data Loggers: TR-51i/52i/ 55i, TR-73U / 74Ui* / 76Ui*
o Data Collection Devices: TR-57DCi, TR-50U2
« For TR-74Ui and TR-76Ui,only the data downloaded via TR-57DCi Base Unit can be used with “T&D Recorder
for Windows”.

Basic Functions

« Recording Settings
Settings can be made for recording conditions such as channel name, recording interval, and recording mode.
By making a recording start (date and time) setting in the main unit(s), the unit(s) will begin recording at that
time on that date.

Graph Display / Printing

« Simultaneous Display of 8 Ch. of Data
It is possible to display up to 8 channels of downloaded data in 1 graph.
e Zoom-in on Data by Mouse
By simple mouse operations, you can easily zoom in and out on data as well as change the display. View the
High, Low, and Average Calculations for any Specified Period Make settings to specify the calculation range
you desire and view the high, low and average value for that range in each channel displayed in the graph.
« Graph Printing
It is possible to print in full-color the graph as you see it on display.
» Data List Display / Printing
You can view the data displayed in the graph window as a list and then choose to print.
« View in Easy to Distinguish Colors
In the data list, the highest value will appear in red, the lowest in blue, and the aver-age in pink.
 Printing the Data List
It is possible to print the entire list as displayed or to select pages for printing.
« Creating Text File
It is possible to convert the data for a specified range (time period) to common text file format (CSV type
format), so that it can be exported to spreadsheet software such as Excel or
 Lotus.
o Possible to use with a mixture of device types (TR-5i Series, TR-73U)

o Itis possible to process recorded data from a mixture of device types.

Basic Procedures

IMPORTANT:
To make sure that the USB driver is properly installed, please follow the correct procedure as outlined here.

USB Communication

« TR-73U, TR-50U2, TR-57DCi



Installing the software

« see P.11,
« Please follow the directions to install “T&D Recorder for Windows TR-5,7xU” . Information on OS compatibility

is available on the Software page of our website at tandd.com/software/.

Connecting the device

« For TR-50U2, TR-57DCi: see P.16, For TR-51i/52i/55i: see P.17, For TR-73U: see P.18

« Enable communication by connecting the Data Logger / Data Collector or Communication Port to the computer
with a USB cable.

« Once the USB cable is connected, the USB driver will automatically be installed.

Making Recording Start Settings

« See [Basic Functions] for each type of device
« IMPORTANT:
Before making [Record Start] Settings make sure that your computer clock settings are correct. If your

computer’s clock is not correct, it will effect the date and time of the recording start.

Downloading Recorded Data

« See [Basic Functions] for each type of device
« Before downloading it is possible to make settings in the [Detailed Settings] to specify the what kind of
processing should be done with the data after download-ing, i.e. open a Graph or assign a file name and save.
« IMPORTANT
Before making Downloading Data make sure that your computer clock settings are correct. If your computer’s

clock is not correct, it will effect the date and time of the data being downloaded.
Serial Communication
« TR-57DCi
Installing the software
o see P11,
« Please follow the directions to install “T&D Recorder for Windows TR-5,7xU”. Information on OS compatibility is
available on the Software page of our website at tandd.com/software/.

Connecting the device

« see P.16, For TR-51i/52i/55i: see P.17
« Enable communication by connecting the Data Logger / Data Collector or Communication Port to the computer
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with the provided or optional Serial Communication Cable.

Setting Up the Communication Port

« see P.19,

« Please follow the directions to install “T&D Recorder for Windows TR-5,7xU” .

Making Recording Start Settings

« see [Basic Functions] for each type of device
IMPORTANT:
« Before making [Record Start] Settings make sure that your computer clock settings are correct. If your

computer’s clock is not correct, it will effect the date and time of the recording start.

Downloading Recorded Data

« See [Basic Functions] for each type of device
« Before downloading it is possible to make settings in the [Detailed Settings] to specify the what kind of
processing should be done with the data after downloading, i.e. open a Graph or assign a file name and save.
« IMPORTANT:
Before making Downloading Data make sure that your computer clock settings are correct. If your computer’s

clock is not correct, it will effect the date and time of the data being downloaded.

Getting Ready

Installing the Software

« Download “T&D Recorder for Windows TR-5,7xU” and “T&D Graph” from the T&D Website and install to your
PC. tandd.com/software/
« After installation, “T&D Recorder for Windows TR-5,7xU” and “T&D Graph” will appear in the Windows Start
Screen or Start Menu.
o If you have no internet access or prefer to install using a software DVD, “T&D Software SO-TD1” is also
available as an option.
o Please contact your distributor for details. ( tandd.com/purchasing/ )
o For details about operations please see the “Help” menu in the software.
« T&D Graph
« T&D Graph is a user-friendly Windows software which brings users effective tools for the management and
analysis of data recorded by T&D Data Loggers. It contains a variety of useful functions including the ability to
read, merge, display, and save multiple recorded data files regardless of the model.
o Note: RVR-52 event data is not supported.

o If the downloaded data file is not associated with T&D Graph, refer to “Troubleshooting” on P.64.

Operating the Software
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« Opening the Software
Open the program from “T&D Recorder for Windows TR-5,7xU” in the Windows Start Menu or Start Screen.
o Launcher Window
Upon opening “T&D Recorder for Windows TR-5,7xU”, a launcher window in which icons are displayed will
appear. By clicking an icon, the graph, settings, and/or communication screen for that type of unit will be
displayed.
« Menu Bar
[Commands are contained in the Start menu, Date Display menu, and Help menu. Icons
By clicking on an icon, the graph or communication display will appear for that type of unit. The graph and
communication displays for each type of unit can also be viewed by clicking on that unit’s type name in [Start]
of the [Menu] Bar.
« Quick Start (TR-73U / TR-50U2)
When Windows is started, the [Quick Start] will be automatically started. When a TR-50U2 or TR-73U Series
device is connected to your computer, the Quick Start will make a search and automatically open the
application.

Please see below for how to quit the Quick Start function and how to restart it again.
Quitting from the Taskbar

1. Click the Quick Start icon in the Task tray to view the popup menu; in the popup menu click on [Quick Start
Settings] .
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2. Place a check next to [Do not use “Quick Start] and click the [OK] Button.
Re-start from the Start Menu or Start Screen

« In the Window’s Start Menu, from the list of programs click on [T&D Recorder for Windows (TR-5,7xU)] —
[Quick Start] to restart the application. In the Start Screen, click on [Quick Start] directly. .

Quit / Start from each application

1. Click on one of the icons (TR-73U, TR-51i / 52i or TR-55i) in the Launcher Window.
2. Click [Software Settings] in the [Settings] Menu.
3. Remove the check mark from next to [Upon Connecting a Thermos
1. Recorder, open the software program.] With no checkmark: Quick Start will be disabled With a
checkmark: Quick Start will be enabled
4. Click the [OK] Button.



Help

« Detailed information on the software can be found in the Software Help Menu.
« See the [Help] Menu of the software for more detailed information about how to use the software.

« To search for unclear words or terms, click the [Help] Menu that appears in the [Menu] Bar and then click on

one of the tabs [Contents], [Index] or [Search].
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« [Contents] Tab

By clicking the mark of the classified topic, an explanation will be displayed.
« [Index] Tab

Select a key word from the key word list and by clicking the [Display] Button, the explanation will be displayed.
« [Search] Tab

Enter the key word you wish to search for and click the [Start Search] Button and the topic in which the key

word is included will be displayed. Then select the topic and click the
« [Display]
Button to have the explanation displayed.
o Click on the [Help] Button in any dialog box and explanations about the dialog box will be displayed.
o In the graph display window, after clicking on the [ ] in the toolbar, you can click on any Menu, any Icon, or
any part of the Main window and an explanation will be displayed.
« “Help for Unit Recognition Failure”
This contains information about how to check whether the USB driver has been properly installed.
« About “T&D Recorder for Windows”

This shows the Version Info for the software.

Date Display Format Settings: [Date Display] Menu
The date format chosen will be applicable for all sections of the software including graphs and setting displays.

1. In the [Date Display] Menu, select [Format Settings] .
2. Check either [Month / Date / Year] or [Date / Month / Year] .

3. By clicking the [OK] Button, the setting will be completed.

Connecting a Data Collector or Communication Port to the Computer



« For TR-50U2, TR-57DCi with USB Communication
o Connect the USB cable (US-15C) to your computer.

— USB Port Mark
%y The USB cable is a USB-A Plug / USB mini-B plug type.

Please connect to a place with this kind of mark.

- USB mini-B Plug USB-A Plug

| USB Cable

Data Communication (US-15C)
Collector Port

TR-57DCi TR-50U2
« Before using, it is necessary to have installed the USB device driver.

» Make sure that the USB cable is inserted fully, so as not to cause an improper connection.
For TR-57DCi with RS-232C (Serial) communication

« Connect the RS-232C (Serial) communication cable to your computer.

Examples of serial port
The communication cable connector is a D-Sub 9 pin
fernale, Connect to a place with a mark as such,

RS-232C Serial Cable

(option: TR-07C) ]:t

Data
Collector

« Make sure to connect it to the correct place to ensure communication.

» Make sure that the cable is inserted fully, so as not to cause an improper connection.
« Make all necessary Communication Port Settings in the Settings / Communication window for the Data Logger
you are using. For details, see [Communication Port Settings] P.19.

Connecting the Data Logger to the Computer

« Connect the Data Logger to the computer using the appropriate method for that type of Data Logger.
« For Data Logger with Optical Communication Compatible Loggers: TR-51i / 52i / 55i

1. Connect the Communication Port to your computer using the provided communication cable.

Communication Cable

2. Place the Data Logger on top of the Communication Port device as shown in the figure, making sure that the
optical communication spots are aligned properly.



TR-57DCi (Data Collector)

Place the Data Logger face down

Communication cable
connected to your computer

« Among the above Data Collector and Communication Port devices, the TR-55i is compatible with TR-57DCi,
TR-50U2 only.\

For TR-73U

« Connect the TR-73U to your computer with the USB Communication Cable (US-15C).
« If necessary, serial communication can be established by using our TR-73U communication protocol (contact
your local dealer) to write a software program. In this case, it will be necessary to connect to your computer

using our optional serial communication cable (TR-07C). Please contact your local provider for more details.

USB Port Mark |

The USB cable is a USB-A Plug <->USB mini-B plug &
type. Please connect to a place with this kind of mark.

il

USB Port
USB mini-B Plug USB-A Plug -~
) y
USB Cable :
(US-15C)

IMPORTANT

« If the place of connection is incorrect, communication will not occur.

« To ensure proper communication, make sure that the communication cable connection is secure.
« The optional serial communication cable TR-07C is necessary for serial communication with PC.

Setting Up the Communication Port

« Settings for both USB and serial port can be made from the same window. It is also possible to confirm current

communication settings.

IMPORTANT



« When using TR-7U / 7Ui Series units, it is not necessary to make COM Port Settings.

« When using USB, the USB driver must be properly installed for USB communication to properly work.

1. Connect the device to your computer via USB or serial cable..
2. Open the appropriate application for the type of device being used. Make settings with TR-5i Series, TR-57DCi
units. By making settings for one unit the same COM Port settings will be made for all device types.

3. In the [Communication] Menu open [Communication Port Settings].

« For an Automatic Search

Check “Communicate via USB” or “Communicate via RS232C”, and click the “Auto Detect” button.
« For using USB

Check “Communicate via USB” and click the “Set” button.
« For using RS-232C

Check “Communicate via RS232C”, select the port number from the “Possible COM Ports” drop-down list, and
click the “Set” button.

IMPORTANT

« If no unit was detected, see “Troubleshooting” on P.63

« If the port number being used is COM9 or above the unit can not be automatically detected.
Basic Function

TR-73U: Display Names and Functions
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« Menu Bar

Commands are contained in the File menu, View menu, Communication menu, Settings menu, and Help

menu.



« Toolbar
The commands that are used most frequently have been arranged as buttons.
« Device and Device Propertied
TR-73U connected to the computer by USB cable will be displayed as icons and information here. In order to
make recording settings or download recorded data, it is necessary to first select a device from the device list.
o Settings Tab
By clicking on the [Download Recorded Data] Tab or the [Start Recording] Tab, you can open the settings

display for that function.

TR-73U: Starting Recording
Connect a TR-73U to your computer so that communication can occur. Please make sure that your computer
clock settings are correct.

« Please see P.18 for more information about how to connect.
« The first time you connect it is necessary to install the USB device driver. For information about how to install
the device driver please see the TR-73U User’s Manual.

« Note: By starting a new recording session, all stored data will be deleted from the device.

[Start Recording] Tab

« Recording Start Date / Time
Selections from: Programmed Start / Immediate Start
Programmed Start: recording will start on the specified date and time. Immediate Start: recording will start
immediately upon completion of settings.
» Recording interval
Select from: 1, 2, 5, 10, 15, 20, 30 seconds 1, 2, 5, 10, 15, 20, 30, 60 minutes
« Recording Mode
Selections from: One-time / Endless
One-time: When the possible number of recorded data readings (8,000 readings per channel) is reached,
recording stops.
Endless: When the possible number of recorded data readings is reached, the oldest data is overwritten and
recording continues.
« Device Name / Channel Name
Make settings for each data logger concerning the device names and channel names.
Device Name: Up to 32 characters
Channel Name: Up to 16 characters
« [Start Recording] Button
Click to send the settings to the data logger and start recording. Once the recording has started, disconnect the
device from the PC and place it at the measurement location.
« [Stop Recording] Button
Clicking this Button will stop a recording session already in progress.
« [Receive Settings] Button
Clicking this will allow you to view recording condition settings and recording status information from the data

logger.



TR-73U: Downloading Recorded Data
Connect a TR-73U to your computer so that communication can occur.

« Please see P.18 for more information about how to connect.
« The first time you connect it is necessary to install the USB device driver. For information about how to install

the device driver please see the TR-73U User’'s Manual.

[Download Recorded Data] Tab

« [Download] Button
Click the [Download] Button to begin downloading data.
[Detailed Settings] Button

Make settings about how to process downloaded recorded data. If you wish to automatically display the graph
upon the completion of downloading, click the [Detailed Settings] Button to make such a setting.
« Graph Display Settings
o By checking here, the graph for the downloaded data will automatically appear after downloading is
completed.
o If the number of channels exceeds 8, it cannot be displayed automatically.
o Please open from a data file or use T&D Graph.
« File Name Settings
o You can choose to save downloaded data using a default file name or by assigning a name each time.
o You can specify the type of default file name under [File] — [File Names and Folders]. For more

information about [Detailed Settings] see next page.

TR-73U: Other Functions

« [File] Menu
o Open Temp / Humidity Graph
o Opens the Temperature / Humidity Graph.
 File Names and Folders
« Specify how you wish the files to be named upon downloading recorded data. Also you can select in which
folder to use to save data for each device.

1. 1. Check which type of file name you wish to use to save data.

Default File Name Settings

Example:
o Device Name: Refrigerator
«» Serial No.: 00001234
« Date and Time: 2023 /05 / 12(yyyy ,mm, dd)at 14:30: 15 / with Data Format
« Extension: TRX
« Device Name Date / Time
« Internal ID+ Date / Time
« Device Name+ Internal ID+ Date / Time: Date / Time Device Name
« ate/ Time Internal ID



« Date / Time Device Name + Internal ID
« Refrigerator_20230512_143015.trx
« 00001234 _20230512_143015.1rx
« Refrigerator_00001234_20230 512_143015.trx 20030512_143015_Refrigerator. trx
20230512_143015_00001234.trx
o 20230512_143015_Refrigerator_00001234.trx
2. Click the name of the device and then click the [Select Folder] Button.
3. The [Browse Folders] dialog box will appear where in you can select
the folder into which you wish to save the data, then click [OK].
4. A [Data Folder] will then appear under Device Properties in the Main Window.
The default setting will create and save data to a folder with the device’s serial number in the same folder

where T&D Recorder for Windows was installed.

o [View] Menu
Large Icon / Small Icon
Changes the icon size in the Device List between large and small.
« [Communication] Menu Monitor Current Readings
o You can monitor at set intervals the current readings of Data Logger or loggers selected from the device

list and have those readings displayed.
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[Settings] Button
This opens a window where settings can be made for the display colors and the monitoring interval for current
readings.
« [Close] Button
Quit the Monitoring of Current Readings.
« [Reset] Button
Click to reset the display for highest and lowest measurements; the new display will show highest and lowest
measurements from the time of resetting.
« [Graph] Button
Click this to hide or view the graph.
« [Clear] Button

Clicking this will clear the graph and a new graph will be drawn from that point.



[Settings] Menu

« Device Name Settings
Device Name and Channel Name can be changed without starting recording.

1. Enter a name.
Device Name: up to 32 characters Channel Name: up to 16 characters

2. By clicking the [Send Settings] Button, the changes will be completed.

LCD Display Settings
Settings can be made for the Thermos Recorder’s LCD display, such as, changing the temperature unit and
turning the display on or off.

« Temp. Unit in Display
o Check either Celsius or Fahrenheit.
o By clicking the [Send Settings] Button, the changes will be completed.
« LCD Display Pattern
o You can select from 4 patterns:
o Alternate display among Ch.1, Ch.2 and Ch.3, Display Ch.1 only, Display Ch.2 only or Display Ch.3 only.

Adjustment Settings

o By setting adjustment values beforehand, you can record and display the post- adjusted measurement
values. You can choose from two adjustment methods: 1-point and 2-point.
o Adjustment will be carried out using an adjustment equation of Y= aX + b; where X is the pre-adjusted

measurement value and Y is the post-adjusted value.

Rough Guidelines for Adjustment

1. point Adjustment: Use when measuring in a range of £20°C.

2. point Adjustment: Use when measuring in a wide range.

IMPORTANT

« When adjusting at 2 points, make sure the difference in points is at least 10°C.

« When measuring in a wide range and adjusting at 2 points, make sure that the adjustment values reflect the
range you are measuring.

« We cannot guarantee that after carrying out adjustment the measuring accuracy will improve for all measuring

ranges.

1. Check the channel you wish to adjust.
2. Place a checkmark next to either [1 Point Adjustment] or [2 Point Adjustment] and enter the [Before] and [After]
values.

3. By clicking the [Send Settings] Button, the adjustment settings will be completed.



The Data Logger can store up to 4 adjustment values, the adjustment history will display up to 4 channels at one
time.

1. Point Adjustment

1. This adjustment method changes only the offset (b) where the slope (a) is considered 1.

2. For example, TR-73U is measuring 10°C, but the standard says the actual measurement should be
10.2°C. Enter 10 in the Before Adjustment box and 10.2 in the After Adjustment box. The conversion
equation will be Y=X + 0.2 and for all measurements an adjustment to the offset of +0.2 will be made.

2. Point Adjustment

1. The adjustment equation will be calculated from two points: the slope (a) and the offset(b).

2. For example, the TR-73U reads 0°C when the standard thermometer reads 0.4°C, and TR-73U reads
10°C when the standard says the true measurement is 10.2°C. In this case the slope(a)is 10.2 - 0.4/ 10-
0 = 0.98. The offset is 0.4, so the conversion equation becomes Y = 0.98X + 0.4. The range of the slope
is 0 < a < = 2. Entries are valid to one decimal point, but after calculation up to four digits are valid for the
slope and offset.

[Initialize] Button
This returns the control settings back to their original factory default settings.
[Save File] Button

Assign a name to the adjustment setting values and save them to a file.
[Read File] Button

Read adjustment setting values from a saved file.

Software Settings

General software settings for TR-73U can be made here.

Upon connecting a Thermos Recorder, open the Software Program
This setting opens the software program upon the connection of a TR-73U unit via USB cable. If the setting is
ON, the Quick Start Program will periodically communicate with the device driver and upon the detection of a

USB connection will open the main software program.

For more details about [Quick Start] and how to quit it, see P.12.

1. Place a check next to [Upon connecting a Thermo Recorder, open the Software Program]. With no checkmark:
Quick Start will be disabled With a checkmark: Quick Start will be enabled
2. Click [OK] to complete the setting.
Temp. Unit to be displayed in Software Program Select whether to use Celsius or Fahrenheit as the displayed
unit of temperature when monitoring current readings and using the adjustment function.
1. Check either unit of temperature (Celsius or Fahrenheit).
2. Click [OK] to complete the setting.

3. After completing settings, please close the TR-73U program and reopen it to make settings effective.

TR-51i/52i/55i: Starting Recording
Connect the Data Logger you wish to make settings for to your computer.

« For details about connecting to your computer, see P.17.



IMPORTANT:
o If the computer system clock is incorrect, a programmed recording start may not start properly. Please
make sure that your computer clock settings are correct.
o By starting a new recording session, all stored data will be deleted from the device.
[Start Recording] Tab
Recording Start Method
Selections from: Programmed Start / Immediate Start.
Programmed Start: recording will start on the specified date and time. Immediate Start: recording will start
immediately upon completion of settings.
Recording Interval
Select from: 1, 2, 5, 10, 15, 20, 30 seconds 1, 2, 5, 10, 15, 20, 30, 60 minutes (Default setting is 10 min.)
Recording Mode
One-time: Upon reaching the storage capacity of 16,000 readings, the word [FULL] will appear on the LCD
display and recording will automatically stop.
Endless: Upon reaching the storage capacity of 16,000 readings, the oldest data
The estimated finish date and time of recording in One-time mode will be automatically calculated from the set
recording interval and starting time.
Channel Name
By placing a check in the [Set] box, you can enter a channel name with up to 8 characters.
Unit of Temperature
Selections from: Celsius (°C) or Fahrenheit (°F) .
Change the display of temperature on the data logger between °C and °F.
Infrared Comm.
o Forbid: Infrared Communication will not be possible.
o Permit: Infrared Communication will be possible.
o If you are using TR-57DCi and do not wish to use infrared communication, we suggest selecting “Forbid”.
(Battery life will be longer.)
o Forbid / Permit settings for infrared communication can also be made from [Infrared Communication
Settings] in the [Communication] menu.
[Start Recording] Button
Use this button to send the settings to the data logger and start recording. Once the recording has started,
disconnect the device from the PC and place it at the measurement location.
[Receive Settings] Button
Use this button to read the settings from the connected Logger.
[Stop Recording] Button
Use this button to stop recording.
[Warning Settings] Button (TR-51i/52i)
Use this button to make warning settings on the TR-51i or TR-52i. (See below).
[Detailed Settings] Button (TR-55i)
Use this button to configure the TR-55i detailed settings such as the sensor type, recording method, etc. (See
next page)
Warning Monitoring Function (TR-51i/52i)
By clicking the [Warning Settings] button in the [Start Recording] tab, the settings window will appear. Place a

check in the [Set Limits] box after entering the Upper and Lower Limits and the Judgment Time.



If these settings are made in an environment where one of the limits is being exceeded and recording is started,
the monitoring function will enter “wait” mode. Once a measurement returns to within the set limits, the monitoring
function will begin to operate.

« Upper Limit / Lower Limit
The Upper / Lower Limits can be set in a range from -60°C to 155°C.
When you wish to change the unit of temperature, go to the [Settings] Menu, open the [Software Settings], and
edit temp. unit.

« Judgment Time

o Selections from: 10, 15, 20, 30 seconds or 1, 2, 5, 10, 15, 20, 30, 60 minutes.

o A warning occurs when a measurement exceeds one of the set Upper / Lower Limits for longer than the
time set as the Judgment Time. The warning LED will flash and a warning message will appear on the
LCD screen.

« Detailed settings can be made for each type of measurement item (TR-55i)

o The [Detailed Settings for Recording Start] window will appear with different setting items depending on
the measurement item. After having made the necessary settings, click the

o [OK] button. You will be returned to the [Start Recording] Tab Window. By clicking the

o [Start Recording] button, the settings will be transmitted to the Data Logger.

« Sensor Type (TR-55i-TC / 55i-Pt)

o Select the type of sensor to be used for the measurement.

o When you replace with a different type of sensor, make sure to change this setting before starting the
measurement/recording.

« Recording Method (TR-55i-V / 55i-mA)
o Select the recording method to be used by the Data Logger.
o Instantaneous Value: Records the instantaneous value at the set recording interval.
» Average Value: Records the value as the average of the measurements
taken during the set recording interval.
« Measurement Range (TR-55i-V)

o Select the range to be used for measurement and in the display of the Data Logger.

o V: Measurement range for the Input Module is set to V Range. The LCD for the TR-55i-V can display
from 0.000V to 22.00V (auto decimal point).

o mV: Measurement range for the Input Module is automatically switched from “mV Range” to “V Range”
depending on the measurement. Input voltage range in the TR-55i-V LCD is 0.0mV to 999.9mV (fixed
decimal point).

« Preheat / Preheat Time (TR-55i-V)

o Select whether to use the preheat function or not. For details about the preheat function, see below.

o When using the preheat function, make settings for the length of time to send current to the sensor. See
below for details.

« What is the Preheat Function?
Preheat is a function which allows the Data Logger to control power to the connected sensor. It transmits a
preheat signal that is synchronized with the recording interval to turn sensors ON before and OFF after
measuring and recording.
What is the Preheat Time?



When using the preheat function, this stands for the length of time to send current to the sensor before
measurement and recording is set to occur. Setting the preheat time to a value that is equivalent to or longer

than the recording interval will supply current to the sensor at all times.

Preheat Time Preheat Time
Current to
u
Sensor OFF ONA OFF ONA OFF
Measure and Record Measure and Record
IMPORTANT

« When using the preheat function, the LCD display will be refreshed based on the recording interval set in the
Data Logger (because sensors only carry out measurement at the set recording time).

« The necessary preheat time varies depending upon the sensor to be used; please check the specifications of
the sensor before making settings for the preheat time.

« Pulse Signal Type (TR-55i-P)

o Make settings for the pulse signal type to be recorded.

o Rising: Records the number of rising pulses during the set recording interval. Falling: Records the
number of falling pulses during the set recording interval.

« LCD Display (TR-55i-P)

o Make settings for the display method for what value is to be shown in the LCD of the Data Logger.

o Pulse Rate: Displays the most recent pulse count in the amount of time set as the recording interval. The
display will be refreshed every one-sixtieth of the recording interval. (When the recording interval is less
than one minute, the refresh interval will be one second.)

« Total Pulse Count: Displays the cumulative number of pulses from 0 to 9999. The displayed count will be
refreshed every one second, and upon exceeding 9999, the count will start over again from 0.
« Chattering Filter (TR-55i-P)
o Select whether or not to use the filter circuit for the chattering which occurs due to changes in polarity.
o Warning Monitoring

o (The setting items vary depending upon the measurement item.)

o If these settings are made in an environment where one of the limits is being exceeded and recording is
started, the monitoring function will enter “wait” mode. Once a measurement returns to within the set
limits, the monitoring function will begin to operate.

o Upper Limit / Lower Limit
The possible setting range varies for each sensor. If the entered value is outside the acceptable range, a
warning message will appear.

« Warning Judgement Time

o Selections from: 10, 30 sec. or 1, 2, 5, 10, 15, 20, 30, 45, 60 min.

o A warning occurs when a measurement exceeds one of the set Upper / Lower Limits for longer than the
set Judgement Time. The warning LED will flash and a warning mark will appear on the LCD screen.

« Target Item for Warning Monitoring (TR-55i-P)

Select the target item from Pulse or Event (rising or falling) and judgement time for warning monitoring.
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TR-51i/52i/55i: Downloading Recorded Data and Checking Warning
Connect the logger to your computer to download the recorded data. If the warning LED flashes on the device,
you can check when the warning was issued.

« For details about connecting to your computer, see P.17.
IMPORTANT:
« |If the Data Collector clock is incorrect, the date and time for wireless recording start and the downloading of

data may be incorrect. Please make sure that the Data Collector clock is correct.

[Download Recorded Data] Tab

« [Download] Button
o Click the [Download] button to start downloading.
o If necessary, you can specify the range of data to be downloaded by checking the [Specify Data by time]
checkbox.
« [Detailed Settings] Button
Settings can be made for the data processing method after downloading.
« After downloading, automatically show graph.
Downloaded data will be automatically saved into a file, and the graph will appear.
o File names cannot be specified.
« After downloading, specify file in which to save data.
The [Save File] dialog box will appear after downloading, where you can assign a name to the file to be saved.
o Graph will not be displayed.
o After downloading, specify file name and automatically show graph. Downloaded data will be saved into a
specified file, which can then be automatically viewed in graph form.
« Automatically save file.
o Downloaded data will be automatically saved into a specified folder. Click the [Browse for Folder] button
to select the folder you wish to save the data into.
o If the folder has not been specified, the file will automatically be stored to the same folder into which the
application was installed.
o [Warning Times] Button
Check the warning occurrence time of the device with the warning LED indication.
IMPORTANT:



o When using Communication Port TR-50C, this function cannot be used.
o Even if more than one warning occurred, only the first one will be shown in the most recent list.
« [Receive most recent time] Button
It is possible to check warning times in the [Warning Occurrence Times] Column.
« [Clear Occurrence Times from Main Unit] button

It is possible to complete the removal.

The warning LED can also be cleared by downloading the recorded data or by starting recording on the device.

TR-51i/52i/55i: Other Functions

« Scale Conversion (TR-55i-V/ mA / P)
Settings can be made here when measuring Voltage, 4-20mA, or
« Pulse with the TR-55i.

o This is the equation to be used for scale conversion. If desired, a string of characters can be input directly
to show the “Unit of

o Measurement” for the value after scale conversion.

o Connect the device to your computer and open [Scale Conversion] from the [Communication] menu.

« IMPORTANT:

o The TR-55i LCD will not reflect changes in the value or unit of measurement after conversion. Convert by
using the equation: y=ax+b

o Select this when the values for both the slope (a) and intercept (b) for the conversion equation are
already known.

o Enter these values in the equation where “x” is the actual input value (in V, m-A, or Pulse) from the
sensor and “y” is the result of the conversion (in the specified unit).

« IMPORTANT:

o Make sure that the slope and intercept are values between —9,999 and +9,999. It is possible to enter

decimals or minus values, but “zero” cannot be entered as the slope.
« Convert by specifying 2 points:

o Select this when both the input values from the sensor (in V, m-A, or Pulse) and the post-conversion
values (in the specified unit) are known at two points. Please make settings after having consulted your
sensor manual for details.

« IMPORTANT:

o Make sure to enter values for the two points so that the slope and the y-intercept of the conversion
equation fall within the range of —-9999 to +9999.

o Itis possible to enter decimals or minus values, but the slope cannot be zero. Also, make sure to make
settings such that the value for “y” will fall between —80,000 and + 80,000.

« Adjustment Settings
Adjustment is a function used to make adjustments to Remote Unit measurements. By making adjustments to
measurements, the adjusted measurements will be displayed and recorded.

« IMPORTANT:

o We cannot guarantee that after carrying out adjustment the measurement, accuracy will improve for all
measuring ranges.

o If you remove a sensor that was connected when adjustment was carried out and then connect a



different sensor, make sure to make new adjustment settings to reflect the actual situation.

o When making “Adjustment Settings” for the TR-55i, the adjustment values will be saved to the Input
Module. Therefore, when an Input Module is replaced, it is necessary to re-make any desired adjustment
settings to be written into the newly connected module.

o If new adjustment settings are made on already adjusted values, the probability of measurement errors
will increase. Make sure to click the [Initialize] button before making any new adjustment settings on
already adjusted values.

When you are carrying out adjustments and formulating equations, please take care with the settings and

take personal responsibility for the process.

1. Connect the Data Logger to your computer. (See P.17.)
2. In the [Communication] Menu, click [Adjustment Settings] to open the settings window.
3. Check the Method of Adjustment: [1 Point Adjustment] or [2 Point Adjustment].
1. Point Adjustment:
Use when measuring in a range of £20°C.
2. Point Adjustment:
Use when measuring in a wide range.
4. Enter the actual measurement before adjustment in the [Before] box and the desired measurement after
adjustment in the [After] box.
For “Rough Guidelines for Adjustment”, see the next page.
5. By clicking the [Send Settings] button, a confirmation message will appear. Then click the [OK] button to

transmit the adjustment settings.

« [Initialize] Button
Clears any previous adjustment equation(s) and initializes the device.
« [History] Column
The latest 4 adjustment history records will be displayed. The records show the date and time that adjustment
settings were made, the adjustment point(s), and the values for “Before” and “After” adjustment.
« [Settings] Menu
Software Settings
« Upon Connecting a Thermo Recorder, open the Software Program
This setting opens the software program upon the connection of a TR-51i/52i/55i unit via USB cable. If the
setting is ON, the Quick Start Program will periodically communicate with the device driver and upon the
detection of a USB connection will open the main software program.
o Place a check next to [Upon Connecting a Thermo Recorder, open the Software Program].
o With no checkmark: Quick Start will be disabled
o With a checkmark: Quick Start will be enabled

For more details about [Quick Start] and how to quit it, see P.12.
« Temp. Unit to be displayed in Software Program

o Select whether to use Celsius or Fahrenheit as the displayed unit of temperature when monitoring

current readings and using the adjustment function.



o After completing settings, please close the TR-51i/52i/55i program and reopen it to make settings

effective.

[Communication] Menu

« Communication Port Settings
o Make settings for USB and/or RS-232C communication IN the TR-51i/52i/55i [Communication] Menu
open [Communication Port Settings].
o For details about Communication Port Setting Procedures see P.19.

TR-57DCi: Setting the Clock

IMPORTANT:
If the Data Collector clock is incorrect, the date and time for wireless recording start and the downloading of data
may be incorrect. Please make sure that the Data Collector clock is correct.

1. Connect the Data Collector to the Computer. For details about connecting to your computer, see P.16.
2. By clicking the icon for the “Data Collector” being used in the Launcher, the settings window will appear.
3. Click the [Set Clock] tab, and make the necessary clock settings.
« Set the specified clock settings.
« If checked: The date / time entered will be set as the date / time in the Data Collector.
« If not checked: The current date / time of your computer will be set as the date / time in the Data
Collector.
4. Click the [Set Clock] button.
Note: If the communication failure occurs...
5. When connected to the computer with a USB cable:
Refer to [Help for Unit Recognition Failure] from the [Help] menu on the launcher, and check the USB device
driver.
When connected to the computer with a serial cable:
Refer to [Troubleshooting] in this manual — [Q. The computer won’t communicate via the Serial Port. What
should |1 do?]

TR-57DCi: Downloading Recorded Data
Here it is possible to download the collected data from the Data Collector to your computer.

IMPORTANT:

« If the computer system clock is incorrect, the date and time of the downloaded data may be incorrect. Please
make sure that the computer system clock is correct.

« If you are unsure of what version you have, please check the version information in the Data Collector’s [Help]
menu.

« When you collect the TR-73U, TR-74Ui, or TR-76Ui’s recorded data with the TR-57DCi, the data is listed with

the model number instead of the device name.

1. Connect the Data Collector to your computer.



For details about connecting to your computer, see P.16.

2. By clicking the TR-57DCi icon in the Launcher, the settings window will appear.

3. Click the [Download Recorded Data] tab, and then click the [Collect Data Info] button to start the gathering of

info.

. When communication has been completed, the data info will appear in the “Data Collector Contents” List.
Details of the “Data Collector Contents” List are described on the next page.

. Select the desired data from the data list and click the [Download Data] button to start the downloading. By
holding down the <Shift> key or <Ctrl> key and clicking on the data you wish to download in the data list, it is

possible to select a multiple sets of data to download at one time.

Settings for Processing after Downloading: [Detailed Settings] Button
You can make settings for the processing of the downloaded recorded data. If you are downloading multiple
sets of data at one time, all operations will be carried out according to the settings made in [Detailed Settings].
After downloading, automatically show graph:
Up to 8 channels of data can be viewed in the same graph window. Moreover, if you save the graph window
using “Save As” command, it is possible to save multiple sets of data into one file.

o If you want to display more than 8 channels of data or temperature/humidity/ voltage/pulse data in the

same graph, install the T&D Graph software.

After downloading, save data in file:
[Assign Data File Name] box will appear. Here you can assign a folder and file name in which to save the data.

It will be saved with 3-digit data No. at the end of the file name.

H'Jfl'Filjl-{ Gr -ﬁ{rh

File Name Data No. Extension Code
.trx : Common Thermo Recorder Type
.vt7 : Voltage Recorder Type File
.thp : TR-73U Type File
Jdur : Illuminance UV Recorder Type File

“Data Collector Contents” List

No. Indicates the data number (1 to 250) assigned in the order of
collection. By clicking the [No.] title area you can change the order
between ascending and descending.

Unit Type TR-51S, etc... indicates the type of unit, such as TR-51S.
ch.1 (Group) Name Shows the Channel 1 Name.
ch.2 (Remote) Name Shows the Channel 2 Name.

Recording Start Date/  Displays the recording start date and time for the data gathered by
Time the Data Collector.

Data Collection Date/  Displays the date and time the data was downloaded from the
Time Data Collector to Computer.



IMPORTANT:

« When using the event recorder function, the recording start time will be displayed even if in the Data Collector
you have selected to download a specific range by time. For details about how to download to the Data
Collector, see the User's Manual supplied with the Collector.

« After gathering data info, it will be saved until the application is closed. However, if you do not close the
application and connect to and transmit info with a different Data Collector or manipulate data from the Data
Collector Unit, the data info stored in the application will be different from that in the Data Collector Unit. Please
gather the data information again.

Other Buttons under [Download Recorded Data] Tab
[Data Info Display] Button

Detailed info will be displayed in the “Data Info Box” about the selected data from the list for downloading. This
can only be done with one set of selected data at a time.
However, info cannot be shown for Event Data.

o [Delete Data] Button

Selected data saved in the the Data Collector will be deleted from the Data Collector.
o [Delete All Data] Button

All data saved in the the Data Collector will be deleted from the Data Collector.
« [Select All] Button

All data in the list will be selected at one time. Use this button to simultaneously download all data.
Graph
The following graphing tools are included in the “T&D Recorder for Windows (TR-5,7xU)” software.

« Temperature / Humidity Graph
For viewing a graph of the downloaded temperature and humidity data.
o Multi-scale Graph

It can display graph channels with different scales simultaneously.

T&D Graph is a Windows software that can be downloaded from T&D Website and used in place of Temperature /
Humidity Graph and Multi-scale Graph. It contains a variety of useful functions including the ability to read, merge,
display, and save multiple recorded data files regardless of the model

Note: RVR-52 event data is not supported.

If the downloaded data file is not associated with T&D Graph, refer to “Troubleshooting” on P.64.
T&D Graph

o tandd.com/software/td-graph.html
T&D Graph Help

o cdn.tandd.co.jp/glb/html_help/tdgraph-help-eng/

Temperature / Humidity Graph
The Temperature / Humidity Graph can be opened by the following methods:


http://tandd.com/software/td-graph.html
http://cdn.tandd.co.jp/glb/html_help/tdgraph-help-eng/

« By clicking the [Temp / Humid Graph] icon in the Launcher.

« Open by selecting [Open Temp / Humidity Graph] in the [File] Menu of the TR-73U, TR-51i/52i/55i Settings and
Communication Window.

« If you have checked [After downloading, automatically display graph] in the detailed settings, the graph

program will automatically open.

IMPORTANT:
When viewing a Graph, small differences in time may occur. For details see “Troubleshooting” on P.64.

Display Names and Functions
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1. Graph Area
« The area in which the Graph is displayed. The horizontal axis shows time and the vertical axis shows
temperature / humidity data.
« When opening a file containing barometric pressure data ([thp] format file), the window is different from
the standard, with the scale for barometric pressure appearing on the right side.
« Horizontal Gauge Bar and Button for Moving Horizontal Axis
« The time axis moves by clicking the [ ] buttons at the left and right of the bar. By dragging the gauge you
can move left and right to the data you want to be displayed.
« The vertical axis moves up or down by clicking the [ Jbuttons at the upper and lower sides of the bar. By
dragging the gauge you can move up and down to the data you want to be displayed.
2. A and B Cursor Bars
By clicking the arrow buttons at the left and right of the bar, you can simultaneously move the A / B cursors.
Click and drag the A or B Button on the bar to move the cursor to the left or right.
3. A and B Cursor Position Information
The approximate date and time for the A and B cursor positions and the time difference between the A cursor
and the B cursor is displayed.



4. Channel Info Display
The detailed data info for each channel 1 to 8 is displayed below the Graph Display.

ch Drag the channel name / number you wish to move to the newly desired channel
name / number position and drop it.

Name  Channel Data Name Interval Recording Interval

Sample Number of data Max. Highest Reading

CursorA Cursor A position data Min. Lowest Reading

CursorB Cursor B position data Avg. Average Value

A<->B  Calculated Temp / Humidity Difference Unit Unit of measurement

between Cursor A and B

5. Menu Bar
Commands are contained in the File menu, View menu, Tools menu, Graph menu, and Help menu.
6. Toolbar (Buttons)

Buttons appear for frequently used commands.

Operating the Graph: [Graph] Menu

« Return to Original Size
Return from zooming in on one part of data
e Zoom In / Zoom Out
Zooms in or out one step at a time
« Move Cursor Right / Left
Simultaneously move the AB Cursors to the right or left.
« Move Graph Right / Left
Move the Graph Display to the right or left.
« Move Graph Up / Down
o Move the Graph Display up or down.
o Vertical Axis Settings (AUTO in Default Settings)

o Set the vertical axis scale (temperature)

AUTO

« The vertical axis will automatically be changed according to the values of the data.

MANUAL: You can set the upper and lower values of the vertical axis scale.

Zoom in Using the Mouse

With the left Button drag the mouse to outline the area you want to zoom in on.

Menu Display Using the Mouse
o By right clicking on the graph, the Menu will be displayed. With [Return to Original Size] or [Step-by Step
Return to Original] you can return both the vertical and horizontal axis back to show the entire graph.
o These operations can be carried out via commands in the [Graph] Menu or by clicking icons in the
Toolbar.
About the Horizontal Axis

o The entire graph shows in the horizontal axis the nearest data to the recording start time and the latest

data nearest the recording finish time for each channel 1 to 8. This represents the full scale of the



horizontal axis.
About the Vertical Axis

o The entire graph shows in the vertical axis the lowest possible measurement value and the highest

possible measurement value for channels 1 to 8. This represents the full scale of the vertical axis.

[View] Menu

o Changing graph display colors

o You can change the letters used in the data list display for each channel between monochrome and

channel color.

Data List Display

o This is a list of the data that was displayed in graph form.

o The highest value is in RED, lowest is in BLUE, and the average is in PINK.
[Date / Time] Button

o By clicking this Button, you can shift the display between the recorded date and amount of elapsed time

since recording started.
Selected Channels ON / OFF

o The channel numbers are displayed in the pull down menu of [Selected Channels ON / OFF].

o Check the channel numbers you wish to display.
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« By clicking a Channel Number in the Toolbar, you can carry out the same operation.
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[Tools] Menu
Set High, Low, Average Calculation Range

1. Set the calculation range in the [Set High, Low, Avg. Calculation Range] box.

2. By clicking the [OK] Button, the high, low, average calculation range of each channel data will be changed. On

the graph display, the calculation range that you have set will be displayed.

« [Entire Graph] Button

To make the Calculation Range that of the Entire Graph, click the [Entire Graph] Button. The dates and times in
the [Set High, Low, Avg. Calculation Range] box will be displayed as those of the entire graph.

« Set by using the AB Cursors

In the Graph Display, open the [Set High, Low, Average Calculation Range] box adjusting the AB cursors to the
desired start and end positions. The dates and times of those cursors will be displayed automatically.

Edit Recording Conditions



1. By clicking the [Ch.] Button you wish to change, the information for that number will be displayed in the [Edit
ltems].

2. By clicking the [OK] Button after changing, the setting will be completed.

IMPORTANT:

« Name: Up to 32 letters can be entered.

« Starting Date / Time: The month, day, year, hour, minute and second can be changed.

« If you wish to continue to change other channels, repeat the process as in 1.

« The [Restore] Button is effective only during the setting, and cannot return to the condition it was after the [OK]

Button has been clicked.

Re-order Channel Data
There are two ways for re-ordering.

Move by dragging the channel nhumber

1. Inthe [Ch.] box, click on the channel number you wish to move, and drag and drop it to the desired channel
position.
2. Click the [OK] Button to apply the change.

Move by selecting the channel number

1. In the [Re-order] box, select the channel number you wish to move from in the “From” field, select the channel
number you wish to move to in the “To” field, and click the [Re-order] Button.

2. 2. Click the [OK] Button to apply the change. IMPORTANT:
The [Restore] Button is effective only during the setting, and cannot return to the condition it was by clicking the
[OK] Button.

« Erase Selected Channel Data
o Put a check on the channel number you wish to erase.
o By clicking on the [OK] Button, the deletion will be completed.
« Shift Unit (°C / °F)
o By clicking on [Shift Unit( °C / °F)], you can automatically change the temperature unit scale in the graph
display and in the channel info list.
« Change Graph Colors
o Here you can change the settings for the background color, scale color for each channel, zoom box, and
AB cursor. It is also possible to change the graph line width for display or printing.

« By clicking the [Return to Default] Button, you will return to the color settings when the software was opened.

Copy Display to Clipboard
By clicking [Copy Display to Clipboard], you can copy the currently displayed window to the clipboard and make
use of the graph by pasting to other software (ex. Excel, PowerPoint).

Multi-scale Graph



« This software, Multi-scale Graph is designed to allow you to view simultaneous display of graph channels with
different scales such as temperature, humidity, voltage, pulse and moisture data in one window.

« The [Multi-scale Graph] program will read data files that have been created from the downloaded data from the
loggers and to help you analyze that data will allow you to create graphs, data lists, text files and print data. It is
also possible to scroll across the graph and make scale settings for each channel.

IMPORTANT
For detailed information about the compatible data file types for the [Multi-scale Graph], see the Multi-Scale
Help Menu.

« Open the Multi-scale Graph by clicking the [Multi-scale Graph] icon in the Launcher.

« Open by selecting [Open Multi-scale Graph] in the [File] Menu.

« If you have checked [After downloading, automatically display graph] in the detailed settings, the graph
program will automatically open.

IMPORTANT
If you have checked [After downloading, automatically display graph] in the detailed settings, the graph
program will automatically open.

Display Names and Functions
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1. Graph Area
The area in which the Graph is displayed. The horizontal axis shows time and the vertical axis shows the unit
of data after having used the conversion equation to convert the original measured voltage.
« The Vertical Axis Display ON / OFF
Shift the vertical axis scale display ON / OFF.
« Vertical Axis of Each Channel




[V A]

The vertical axis scale is displayed for each channel. By clicking buttons, the axis can be
scrolled for each channel.

2. A/ B Cursor Movement Buttons and A / B Cursor Buttons
By clicking one of the arrow buttons at either side of the bar, you can simultaneously move the A/ B cursors.
Click and drag the A or B Button to move the cursor to the left or right.

3. A/ B Cursor Position Information
The approximate date and time for the A and B cursor positions and the time difference between the A cursor
and the B cursor is displayed.

4. Channel Info List Display
Displays data information for Channels 1 to 8. The list contains the following info: Channel Name, Recording
Interval, Amount of Data, Data Values for AB Cursor positions, the High, Low and Average values for the set
calculation range.

5. Menu Bar
Commands are contained in the File menu, View menu, Tools menu, Graph menu, and Help menu.

6. Toolbar

Buttons appear for frequently used commands.
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1. Open File
2. Overwrite Data
3. Data List Display
4. Return to Original Size
5. Step by Step to Original
6. Set High, Low,
7. Avg. Calculation Range
8. Edit Recording Conditions
9. Re-order Channels
10. Merge Channel Data
11. Erase Selected Channel Data Print Preview
12. Help

13. Hide / View Channels

« Horizontal Gauge Bar and Button for Moving Horizontal Axis
By dragging the gauge you can move left and right to the data you want to be displayed. The time axis moves
by clicking these arrow buttons.

« Vertical Gauge Bar and Button for Moving Vertical Axis
By dragging the gauge you can move up and down to the data you want to be displayed. The vertical axis

moves up or down by clicking these arrow buttons.

Calculation Range Button

By clicking the [Calculation Range] Button, the high, low, average calculation range of each channel data will be
changed. On the graph display, the calculation range that you have set will be displayed. This operations can be
carried out via commands in the [Tools] Menu. See P.56 for details.



Zooming In and Out on the Graph

e Zoom in Using the Mouse
With the left Button drag the mouse to outline the area you want to zoom in on.
« Menu Display Using the Mouse
By right clicking on the graph, the Menu will be displayed. With [Return to Original Size] or [Step-by Step

Return to Original] you can return both the vertical and horizontal axis back to show the entire graph.

[View] Menu

« View Data List...
o This is a list of the data that was displayed in graph form.
o The highest value is in RED, lowest is in BLUE, and the average is in PINK.
« [Date / Time] Button
o By clicking this Button, you can shift the display between the recorded date and amount of elapsed time
since recording started.
o This is a list of the data that was displayed in graph form.
o The highest value is in RED, lowest is in BLUE, and the average is in PINK.
« Scroll Bar: By dragging it up and down you can move to the data you want.
« Menu Display Using the Mouse
o By right clicking on the list, the Menu will be displayed.
« Selected Channels ON / OFF
o The channel numbers are displayed in the pull down menu of [Selected Channels ON / OFF].

o Check the channel numbers you wish to display.

o The channel numbers are displayed in the pull down menu of [Selected Channels ON / OFF].

Check the channel numbers you wish to display

« Scale Display ON / OFF
o The channel numbers are displayed in the pull down menu of [Selected Scale ON / OFF].
o Put a check next to the channel number(s) you wish to be displayed.

o You can also hide or view channel scales by checking the channel number of the left of the graph.

[Tools] Menu

« Setting High, Low, Average Calculation Range
Set the calculation range in the [Set High, Low, Avg. Calculation Range] box.
By clicking the [OK] Button, the high, low, average calculation range of each channel data will be changed. On
the graph display, the calculation range that you have set will be displayed.
« [Entire Graph] Button
To make the Calculation Range that of the Entire Graph, click the [Entire Graph] Button. The dates and times in
the [Set High, Low, Avg. Calculation Range] box will be displayed as those of the entire graph.
Set by using the AB Cursors
In the Graph Display, open the [Set High, Low, Average Calculation Range] box adjusting the AB cursors to the

desired start and end positions. The dates and times of those cursors will be displayed automatically.



Editing Recording Conditions
Here you can change channel names and/or recording start times.

1. By clicking the Ch. Button you wish to change, the information for that number will be displayed in the “Edit
ltems”.
2. Enter the desired channel name and starting date and time.
« Name: Up to 32 letters can be entered.
« Starting Date / Time: The month, day, year, hour, minute and second can be changed.
« The [Restore] Button is effective only during the setting, and cannot return to the condition it was after the
[OK] Button has been clicked.
3. Click the [OK] Button.

If you wish to continue to change other channels, repeat the process as in 1.

Re-ordering Channel Data
There are two ways for re-ordering.

Move by dragging the channel humber

1. In the channel box, click on the channel name you wish to move, and drag and drop it to the desired channel
position.
2. Click the [OK] Button to apply the change.

Move by selecting the channel nhumber

1. In the [Re-order] box, select the channel humber
you wish to move from in the “Select1” field, select the channel number you wish to move to in the “Select2”
field, and click the [Change 1 and 2] Button.

2. Click the [OK] Button to apply the change.

Merging Channel Data
You can merge two different sets of data into one set of data.

1. s you wish to merge.

Example: If you wish to merge Ch.3 with Ch.7

Merge 3ch. v with 7ch, -

2. By clicking the [Merge] Button, the merging will be completed.
« The following kinds of data cannot be merged:
« Recording intervals are different
« Measurement times overlap (Merging is possible after adjusting the times in [Editing Recording
Conditions])

« Data types are different (Merging is possible between same types of data; like temperature / humidity)



IMPORTANT
The channel number and other conditions of the merged data will become those conditions set in the channel that
you selected in the second box.

Erasing Selected Channel Data

1. Put a check on the channel number you wish to erase.

2. By clicking on the [OK] Button, the deletion will be completed.

Vertical Axis Range Display Settings
You can set the upper and the lower limits of the graph’s vertical axis scale for each channel.

1. Set CH.1 [Fixed] and by putting a check on [Make all Settings the same as Ch.1]; all channel settings will be the
same as CH.1 regardless of other channel settings.

2. Enter upper and lower limit values.
Set the lower limit at more than -40,000 and set the upper limit at less than 40,000.

3. Click the [OK] Button.

IMPORTANT
If you have put a check on [Fixed], the lines in the graph may exceed the boundaries of the graph.

Scale and Unit Conversion
You can convert the scale and the unit of downloaded data for each channel.

1. Select from [Designate by 2 points] Tab or [Designate by y=ax+b] Tab.
Current conversion formulas and units are displayed in Conversion Info. Y indicates the data after conversion,
and x indicates the voltage entering from the sensor.

2. Set conversion formulas and units.

3. Click the [OK] Button.

Changing Graph Colors
You can change the graph color and line width settings here. You can save the settings for Display and/or Print
respectively.

1. Select Display or Print.
2. By clicking the [Save] Button, the settings will be saved.
By clicking the [View] Button, you can see the settings that had been previously saved.
3. Click the [Channel Number] Button, and click the Button of the item that you wish to change.
when changing colors, click on a Button to display the color samples. Choose the desired color and click the
[OK] Button to change the color.
If you wish to change line width, every time you click the [ A ¥ ] Button, the width gets wider or narrow.
4. Click the [OK] Button.

[File] Menu

If you have checked [After downloading, automatically show graph.], make sure to save data after displaying the
graph or editing any data.

3 Ways to Save Files



o Overwrite All Data
Will save any changes to file without changing File Name and Saving Location. The same operation can be
carried out from [Save] in the Toolbar.

« Save All Data as...
Save with a new File Name. Specify the [Location] and enter a [File Name].

« Save Displayed Data

Save only that data in the current display. This is handy when you wish to save only the desired data.

Creating Text File

By saving the recorded data as text file, you can create a file type that can be read by common spreadsheet
software.
IMPORTANT:

« The extension for the created file will be [.txt].

« Data output in text format cannot be read by T&D’s graph applications.

1. Click [Save Data in Text File] in the [File] Menu.

2. Select the [Text File Type] and [Range to be saved], and click [OK]. Comma, Tab, Space, and Semi-colon are
codes used by common spreadsheet software, such as Excel and Lotus, when reading Text File to divide cells.

3. Designate the location to which the file should be saved and click [Save] to create and save the data as a Text
File document.

Opening a File

To open a previously saved file, designate the file name to open it. To open multiple files at once, hold down the
<Ctrl> key and select the files you wish to open.

1. Select [Open] in the [File] Menu.

2. Select the name of the data you wish to open and click [Open] to view the data in graph form.

Troubleshooting

Q: The computer won’t communicate via the Serial Port. What should | do?
A: Please check the following

« Try two or three times to find the port connection by using the Auto-detect function.
Check to make sure that the power of the main unit is ON.

« Check to make sure that the connection is proper. Communication will take place only through the serial port
(RS-232C) and will not work through the printer port or any other port.

« Check to make sure that you can control the Thermo Recorder via the software.

« If you have access to another computer, try seeing if communication works with the other computer.

« If you have a computer with energy saving function settings, make sure that the serial port has not been turned
off.

« Check to make sure that the serial port has not been rendered unusable by the BIOS setting.



« Make sure that the serial port setting has not been made to render the port unusable. With some computers,
especially
all-in-one computers the serial port serves as the modem jack.

« If your computer has an internal modem, make sure that the communication port is not being used by it. When
the communication port is being used as the modem port, that port cannot be used. Either quit using the
modem or use another port.

« Sometimes communication will not work if a switch has been added to the serial port (RS-232C) or an
extension cable has been added to the communication cable.

« heck to see if some other communication software is in use.

« if your desktop computer has two serial ports, try connecting the communication cable to the other port and try

communicating again.

How to check the status of a COM port

. Open the Device Manager.
Right click the [Start] button and select [Device Manager].
2. In the Device Manager, click on [Ports (COM & LPT)] and check to see that if under that appears
[Communications Port (COM1)].
(Note that COM1 is an example. The actual COM port number will vary depending on the available ports.) If a
port appears, it should be usable.
3. If amark “I” or “x” appears next to the port, this communication port is unusable. If you cannot use a
communication port please contact the manufacturer of your computer.
To find out details about any communication port with “!”, right click on the port and select [Properties] where

you can check the status of the device.

Q: The date and the time of the recorded data are different from the actual date and time of recording.
Why?

o A: The Thermo Recorder has no internal clock. When you set up a programmed recording start or when you
download data, the date and time that are shown are taken form your computer’s clock. If your computer’s
clock is not correct, it will affect the recorded data.

When recording mode has been set to [Endless] and Recording Start was carried out via PC, the time for
recorded data is calculated from the recording start date and time and will appear correctly in the Graph as
long as recording capacity has not reached its limit. However, once data capacity has become full and the
oldest data is overwritten, the date and time for downloaded data in the Graph will be calculated using the PC’s
clock for the latest recorded data and subtracting backward. Hence the time for the displayed data will be

different from the actual time the data was recorded.

Q: l installed T&D Graph, but the downloaded file is associated with another program and cannot be
opened with T&D Graph. What should | do?
A: Follow the steps below to change file associations.

1. In the data storage location, right-click on the graph file (.trz) and select [Properties].
2. In the General tab of the Properties window, click the [Change] button.
3. Select “T&D Graph” from the list that appears and click [OK].



4. If “T&D Graph” is not in the list, select “TandDGraph.exe” in the installation folder. Default Installation Folder:
C:\Program Files (x86)\T&D Graph

« Product Support
o For support, please contact the distributor from which you purchased the product.
o A list of distributors can be found at: tandd.com/purchasing/

« Product Information
o Product information can be found at: tandd.com/product/

Documents / Resources

T D TR-5 Recorder Window [pdf] User Manual
TR-5 Recorder Window, TR-5, Recorder Window, Window
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